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Overview
Stellar Phoenix Access Recovery, a secure and easy to use application designed for repairing
corrupt Microsoft Access (.mdb, .accdb) files. The simple, intuitive and cool looking user interface
makes the software easily operable. The software does a complete scan of the corrupt access files.
After that, files are repaired and restored to a default location or to a user specified folder.
Access is a versatile application for creating database, which is susceptible to corruption. Stellar
Phoenix Access Recovery is an ideal solution for repairing and retrieving corrupted access files. The
software repairs the files in a safe and non-destructive manner.
New in Stellar Phoenix Access Recovery v3.0:
• Supports MS Access 2007.
Key Features:
• Recovers deleted tables, forms, reports, queries, modules and macros.
• Recovers relations in access database.
• User-friendly and secure software.
• Quick recovery and repair of corrupted files.
• Supports MS Access 2000 / 2002(XP) / 2003.
• Compatible with Windows 9x / Me / NT / 2000 / XP / 2003 / Vista.

Note:
Stellar Phoenix Access Recovery is available in - Demo (free download) and Full
Version. You can download the demo version from www.repair-accessfile.com/download-access-file-recovery.php. The demo version will scan your
corrupt Access database, repair it, and show a preview of the recovered tables in
the database, but will not output the repaired file. To get the repaired file, you
need to purchase and activate the product.
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Minimum System Specification
Processor : Pentium Class

Operating System : Windows 9x / Me / NT / 2000 / XP / 2003 / Vista
Memory : Minimum 64 MB (128 MB recommended)
Hard Disk : 20 MB of free space
MS Access : Access 2000 / 2002 (XP) / 2003 / 2007

Note:
•

To know your Operating System, Processor type, and RAM, right-click My Computer and
click Properties.

•

To find out the available space on a logical drive, right click that drive icon in My Computer
and click Properties.

Installation Procedure

Before beginning installation, make sure that your computer meets minimum system requirements.



The installation process should start automatically on inserting the Access Recovery disc in
its drive. If it does not, run sar.exe from the software disc. If the software has been
downloaded from the Internet, navigate to the location where the files have been downloaded
and run sar.exe from there.



Follow the instructions as directed by the setup program. The program installs the software,
creates a shortcut icon on the desktop or on the taskbar (optional), creates an entry in the
Programs group menu, and creates an entry in the Add/Remove Programs group for software
removal.
The default path for software installation is C:\Program Files\Stellar Phoenix Access
Recovery\.
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On-screen instructions directed by the setup program are as follows:

Step 1:

Step 2:
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Step 3:

Step 4:
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Step 5:

Step 6:
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Step 7:

Uninstalling the software
Stellar Phoenix Access Recovery can be removed either by using Uninstall Stellar Phoenix Access
Recovery program in the software or from Add/Remove Programs in the Control Panel.



The Uninstall program in the software may be run by clicking Start->Programs->Stellar
Phoenix Access Recovery->Uninstall Stellar Phoenix Access Recovery. Follow the
instructions as directed by the uninstall program. The program will completely remove the
software, including registry entries.



The Uninstall program in the software may also be run from the Add/Remove Programs list in
Control Panel. The Control Panel window may be opened either by clicking Control Panel
from the Start menu, or by double-clicking the Control Panel icon in My Computer. In Control
Panel, double-click Add/Remove Programs. Select the Stellar Phoenix Access Recovery
entry from the displayed list and click Change/Remove. Follow the instructions as directed by
the uninstall program. The program will completely remove the software, including registry
entries.
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On-screen instructions directed by the uninstall program are as follows:

Step 1:

Step 2:

Step 3:
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Order and Activate the Software
Order Stellar Phoenix Access Recovery online:
You can purchase the software online. For price details and to place the order, please visit www.repairaccess-file.com/buy-now.php?accessrepair_ord
Once your order is confirmed, a pre-paid serial # will be sent to you through e-mail, which would be
required to activate the software.

Activate Stellar Phoenix Access Recovery:
Once the software has been purchased and the Serial Key received, the software needs to
be activated.
Each time you start the demo version, reminder window pops up. To continue with the demo version,
you have to click OK. (Wait for 5 seconds to enable OK button)
To purchase full version, click Buy Now and to activate the product, click Enter Key.

Activating the software before application startup
When you run the demo version, reminder message window as shown above will pop up. To activate
the product, click Enter Key.
In the window that appear (shown below), enter the valid registration name and key (prepaid serial
key received through email after purchase) and click OK to continue. If the key entered is valid,
confirmation message will appear, click OK. Now, you have successfully activated the product.
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Activating the software within the application
If the software is not activated before application startup, it can be done within the
application.
To activate, do one of the following:



Select Activate Stellar Phoenix Access Recovery v2.0 from the Help menu.



Click on the Activate button, in the popup window shown below. [The following
window popup, when you try to repair the file ( ie, when you click on Start Repair ) in
demo version.]

If you click OK, repair process continues and preview of the repaired file will be displayed in
the right pane. The repaired file will not be saved to the system. For that, you have to
purchase the full version. To purchase the product, click Buy Now.

The activation window shown below will appear, enter the user name and activation code
(received through email after purchasing the product) and click OK.
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Using the Software
Stellar Phoenix Access Recovery is powerful and easy to use file repair software capable of
repairing/fixing any corrupted access file. The user interface is simple and comprehensive, which
gives a complete idea about the software. The functionality of the software is easily understandable.
Stellar Phoenix Access Recovery is a toolbar driven software, which does not require any prior skills
to work with. Besides toolbar, the menu bar provides many more commands that are applicable.

Open the corrupt access (.mdb) file
Click Select/Open MS Access File icon on the Toolbar.
or
Select Open MS Access File option from the File menu.
Navigate to the access (.mdb) file, select it and click Open. The selected file will be added to the
treeview in the left pane.

Repair Corrupted File
Click Start Repair icon () on the Toolbar.
or
Select Start Repair option from the File menu.
You will be prompted by a window, in which you have to select the destination location. The
recovered files can be saved to the default location or you can specify the folder. After selecting the
destination click OK to continue. The software scans the entire file and identifies the cause of
corruption. Then, it repairs the damage and retrieves file to its original state.

Note :
You get a clear idea about the repairing process and a preview of the repaired file(s)
from the demo version. If satisfied, purchase the full version and avail full functionality
software.
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Legal Notices
Copyright
Stellar Phoenix Access Recovery software, accompanied user manual and documentation are
copyright of Stellar Information Systems Ltd, with all rights reserved. Under the copyright laws, this
user manual cannot be reproduced in any form without the prior written permission of Stellar
Information Systems Ltd. No Patent Liability is assumed, however, with respect to the use of the
information contained herein.
©1995-2008 Stellar Information Systems Ltd. All rights reserved.

Disclaimer
The Information contained in this manual, including but not limited to any product specifications, is
subject to change without notice.
STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD TO THIS
MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY EXPRESSLY
DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR INFORMATION
SYSTEMS LTD ASSUMES NO LIABILITY FOR ANY DAMAGES INCURRED DIRECTLY OR
INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR OMISSIONS CONTAINED
HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE MANUAL. IN NO EVENT
SHALL STELLAR INFORMATION SYSTEMS LTD, BE LIABLE FOR ANY INCIDENTAL,
CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER BASED ON TORT, CONTRACT
OR OTHERWISE, ARISING OUT OF OR IN CONNECTION WITH THIS MANUAL OR ANY OTHER
INFORMATION CONTAINED HEREIN OR THE USE THEREOF.

Trademarks
Stellar Phoenix Access Recovery® is a registered trademark of Stellar Information Systems Ltd.
Windows 95®, Windows 98®, Windows Me®, Windows NT®, Windows 2000®, Windows2003®,
Windows XP® and Windows Vista® are registered trademarks of Microsoft Corporation.
All other brand and product names are trademarks or registered trademarks of their respective
companies.
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License Agreement
Stellar Phoenix Access Recovery Copyright © 1995-2008 Stellar Information Systems Ltd.
All rights reserved.
This license applies to the standard-licensed version of Stellar Phoenix Access Recovery.
Stellar Phoenix Access Recovery License.
Stellar Information Systems Ltd.

Your Agreement to this License
You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by Stellar Information Systems Ltd.
If you do not agree to all of the terms and conditions of this License, then: do not copy, install,
distribute or use any copy of Stellar Phoenix Access Recovery with which this License is included,
you may return the complete package unused without requesting an activation key, within 30 days
after purchase, for a full refund of your payment.
The terms and conditions of this License describe the permitted use and users of each Licensed
Copy of Stellar Phoenix Access Recovery. For purposes of this License, if you have a valid singlecopy license, you have the right to use a single Licensed Copy of Stellar Phoenix Access Recovery; if
you or your organization has a valid multi-user license, then you or your organization have - has the
right to use up to a number of Licensed Copies of Stellar Phoenix Access Recovery equal to the
number of copies indicated in the documents issued by Stellar when granting the license.
Scope of License
Each Licensed Copy of Stellar Phoenix Access Recovery may either be used by a single person or
used non-simultaneously by multiple people who use the software personally installed on a single
workstation. This is not a concurrent use license.
All rights of any kind in Stellar Phoenix Access Recovery, which are not expressly granted in this
License, are entirely and exclusively reserved to and by Stellar Information Systems Ltd. You may not
rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works
based on, Stellar Phoenix Access Recovery, nor permit anyone else to do so. You may not make
access to Stellar Phoenix Access Recovery available to others in connection with a service bureau,
application service provider, or similar business, nor permit anyone else to do so.
Warranty Disclaimers and Liability Limitations.
Stellar Phoenix Access Recovery, and any and all accompanying software, files, data and materials,
are distributed and provided AS IS and with no warranties of any kind, whether expressed or implied.
In particular, there is no warranty for the quality of data recovered. You acknowledge that good data
processing procedure dictates that any program, including Stellar Phoenix Access Recovery, must be
thoroughly tested with non-critical data before there is any reliance on it, and you hereby assume the
entire risk of all use of the copies of Stellar Phoenix Access Recovery covered by this License. This
disclaimer of warranty constitutes an essential part of this License.
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In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix Access
Recovery in applications or systems where Stellar Phoenix Access Recovery's failure to perform can
reasonably be expected to result in a significant physical injury, or in loss of life. Any such use is
entirely at your own risk, and you agree to hold Stellar harmless from any and all claims or losses
relating to such unauthorized use.
General
This License is the complete statement of the agreement between the parties on the subject matter,
and merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction
and venue for all matters relating to this License shall be in courts and fora located in the State of
Delhi, INDIA and you consent to such jurisdiction and venue. There are no third party beneficiaries of
any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any
violation of this License by you shall not constitute, nor contribute to, a waiver by Stellar of any other
or future violation of the same provision, or any other provision, of this License.
Copyright ©1995-2008 by Stellar Information Systems Ltd. All rights reserved.
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Technical Support

Our Technical Support professionals will give solutions for all your queries related to Stellar Products.
You can either Call Us or Go Online to our support section www.repair-access-file.com/support.php

Support Helpline
24 Hrs. a day

Monday – Friday

USA (Toll free - Pre Sales Queries)

-

1-866-554-2512

USA (Post Sales Queries)

-

1-315-220-6245

UK (Europe)

-

+44-207-993-2293

Germany

-

+49-180-110-105-0051

Worldwide

-

+91-921-395-5509

Skype Id

-

stellarsupport

Online Help
Chat Live with an Online technician
Search in our extensive Knowledge Base
Submit Ticket (If our Knowledge Base does not answer your question)
Login and view Ticket Status (If you already have a valid Ticket with you)
Download Documents on Product Usage ( For Registered members
only, i.e., user with login ID. If you are an unregistered user, please visit
http://stellarinfo.com/esupport/users/login.php to create login ID)
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Welcome to Stellar

Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data
Protection Software for more than a decade.
We provide the widest range of Data Recovery Products. Our range includes Data Recovery
Software for almost all Operating Systems and File Systems.
Product line:
Data Recovery : A widest range of data recovery software that helps you recover your valued data
lost after accidental format, virus problems, software malfunction, file/directory deletion, or even
sabotage!. More Info >>
File Recovery: The most comprehensive range of file undelete and unerase software for Windows
and MS office repair tools. More Info >>
Email Recovery: A wide range of mail recovery, mail repair and mail conversion applications for MS
Outlook, MS Outlook Express and MS Exchange useful in instances of data loss due to damages and
corruption of Email. More Info >>
Data Protection: A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring
Applications to ensure complete data protection against hard drive crash. More Info >>
Data Sanitization: Data cleanup and file eraser utility can delete selected folders, groups of files,
entire logical drives, System Traces & Internet traces. Once the data have been removed using
Stellar Wipe - Data File eraser utility, it is beyond recovery limits of any Data Recovery Software or
utility. More Info >>
For more information about us, please visit www.stellarinfo.com
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